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1  Safety Information
The R&S RTP oscilloscope is designed for measurements on circuits that are only indi-
rectly connected to the mains or not connected at all. It is not rated for any measure-
ment category.

The instrument is rated for pollution degree 2 - for indoor, dry location use where only
non-conductive pollution occurs. Temporary conductivity caused by condensation is
possible.

The instrument must be controlled by personnel familiar with the potential risks of mea-
suring electrical quantities. Observe applicable local or national safety regulations and
rules for the prevention of accidents.

Safety information is part of the product documentation. It warns you about the poten-
tial dangers and gives instructions how to prevent personal injury or damage caused
by dangerous situations. Safety information is provided as follows:

● The "Basic Safety Instructions" in different languages are delivered as a printed
brochure with the instrument.

● Throughout the documentation, safety instructions are provided when you need to
take care during setup or operation.

Risk of injury
Use the instrument in an appropriate manner to prevent electric shock, personal injury,
or fire:
● Do not open the instrument casing.
● Do not use the instrument if you detect or suspect any damage of the instrument or

accessories.
● Do not operate the instrument in wet, damp or explosive atmospheres.
● Make sure that the instrument is properly grounded.
● Do not use the instrument to ascertain volt-free state.

Risk of injury
Do not exceed the voltage limits given in Chapter 4.1, "Front Panel", on page 17.
The instrument is heavy. Be careful when you lift or carry the instrument.
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Risk of instrument damage due to inappropriate operating conditions
An unsuitable operating site or test setup can damage the instrument and connected
devices. Before switching on the instrument, observe the information on appropriate
operating conditions provided in the data sheet. In particular, ensure the following:
● All fan openings are unobstructed and the airflow perforations are unimpeded. A

minimum distance of 10 cm to other objects is recommended.
● The instrument is dry and shows no sign of condensation.
● The instrument is positioned as described in the following sections.
● The ambient temperature does not exceed the range specified in the data sheet.
● Signal levels at the input connectors are all within the specified ranges.
● Signal outputs are connected correctly and are not overloaded.
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2  Preface

2.1  Key Features

The R&S RTP high-performance oscilloscopes combine superior signal integrity with
fastest acquisition rate. It combines multiple instrument capabilities for time-correlated
debugging in one box. Outstanding key features are:

Real-time signal integrity
● Superior frontend performance
● Real-time de-embedding and advanced triggering
● Hardware accelerated processing for faster results
● Comprehensive analysis tools, for example, powerful protocol analysis, jitter analy-

sis functions, automatic compliance tests, spectrograms, and precise and wide-
band RF analysis

Multiple instrument capability
● Time-correlated analysis of different signal types
● Easy-to-use serial protocol analysis for various protocols used in embedded

design, mobile communications and more
● General purpose mixed signal option
● Multi-channel power consumption analysis with up to 8 additional voltage and 8

additional current measurement channels and very high dynamic range

Compact and configurable
● Most compact high-end instrument platform
● Highest configuration flexibility
● Advanced user interface

For a detailed specification, refer to the data sheet.

2.2  Documentation Overview

This section provides an overview of the R&S RTP user documentation.

2.2.1  Manuals and Instrument Help

You find the manuals on the product page at:

www.rohde-schwarz.com/manual/rtp

Documentation Overview

http://www.rohde-schwarz.com/manual/rtp
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Getting started manual

Introduces the R&S RTP and describes how to set up and start working with the instru-
ment, and describes basic operations. A printed English version is included in the
delivery. Editions in other languages are available on the product website.

Instrument help

The help offers quick, context-sensitive access to the complete information for the firm-
ware basic functionality and applications.

User manual (Instrument)

Describes all instrument functions in detail. It also provides an introduction to remote
control, a complete description of the remote control commands with programming
examples, and information on maintenance and instrument interfaces. Includes the
contents of the getting started manual.

The online version of the user manual provides the complete contents for immediate
display on the internet.

Manuals for compliance test options

For compliance test options, extra test procedure manual are available. Test fixtures
are described in printed manuals, which are delivered with the fixture.

● The following test procedure manuals are available:
– USB 2.0 Compliance Tests for R&S RTP
– Ethernet Compliance Tests for R&S RTP
– MIPI D-PHY Compliance Tests for R&S RTP
– DDR3 Compliance Tests for R&S RTP
– ScopeSuite Automation

● The following test fixture manuals are available:
– R&S RT-ZF1 USB 2.0 Compliance Test Fixture Set
– R&S RT-ZF2 Ethernet Compliance Test Fixture Set
– R&S RT-ZF3 Frequency Converter Board (100BASE-T1)
– R&S RT-ZF4 10BASE-Te Test Fixture
– R&S RT-ZF5 Ethernet Probing Fixture
– R&S RT-ZF6 Frequency Converter Board (1000BASE-T1)

Basic safety instructions

Contains safety instructions, operating conditions and further important information.
The printed document is delivered with the instrument.

Instrument security procedures manual

Deals with security issues when working with the R&S RTP in secure areas.

Documentation Overview
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Service Manual

Describes the performance test for checking the rated specifications, module replace-
ment, firmware update, troubleshooting and fault elimination, and contains mechanical
drawings and spare part lists. The service manual is available for registered users on
the global Rohde & Schwarz information system (GLORIS, https://gloris.rohde-
schwarz.com).

2.2.2  Data Sheet and Brochure

The data sheet contains the technical specifications of the R&S RTP. It also lists the
options with their order numbers and optional accessories. The brochure provides an
overview of the instrument and deals with the specific characteristics.

See www.rohde-schwarz.com/brochure-datasheet/rtp

2.2.3  Release Notes, Open Source Acknowledgment

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation. The open source acknowledg-
ment document provides verbatim license texts of the used open source software. It
can also be read directly on the instrument.

See www.rohde-schwarz.com/firmware/rtp.

2.2.4  Application notes, Application cards, Videos

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/rtp

Documentation Overview

https://gloris.rohde-schwarz.com
https://gloris.rohde-schwarz.com
http://www.rohde-schwarz.com/brochure-datasheet/rtp
http://www.rohde-schwarz.com/firmware/rtp
http://www.rohde-schwarz.com/application/rtp
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3  Preparing for Use
This section describes the basic steps to be taken when setting up the R&S RTP for
the first time.

Observe the information on appropriate operating conditions provided in the data sheet
and the general information given in "Risk of instrument damage due to inappropriate
operating conditions" on page 6.

3.1  Unpacking and Checking the Instrument

To remove the instrument from its packaging and check the equipment for complete-
ness, proceed as follows:

1. Pull off the polyethylene protection pads from the instrument's rear feet.

2. Carefully remove the pads from the instrument handles at the front.

3. Pull off the corrugated cardboard cover that protects the rear of the instrument.

4. Carefully unthread the corrugated cardboard cover at the front that protects the
instrument handles and remove it.

5. Check the equipment for completeness using the delivery note and the accessory
lists for the various items.

6. Check the instrument for any damage. If there is damage, immediately contact the
carrier who delivered the instrument. Make sure not to discard the box and packing
material.

Packing material
Retain the original packing material. If the instrument needs to be transported or ship-
ped later, you can use the material to protect the control elements and connectors.

3.2  Positioning the Instrument

The instrument is designed for use under laboratory conditions. It can be used in
standalone operation on a bench top or can be installed in a rack.

3.2.1  Bench Top Operation

For standalone operation, place the instrument on a horizontal bench with even, flat
surface. The instrument can be used in horizontal position, standing on its feet, or with
the support feet on the bottom extended.

Positioning the Instrument
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Risk of injury if feet are folded out
The feet can fold in if they are not folded out completely or if the instrument is shifted.
Collapsing feet can cause injury or damage the instrument.
● Fold the feet completely in or out to ensure stability of the instrument. Never shift

the instrument when the feet are folded out.
● When the feet are folded out, do not work under the instrument or place anything

underneath.
● The feet can break if they are overloaded. The overall load on the folded-out feet

must not exceed 500 N.

Risk of injury when stacking instruments
A stack of instruments can tilt over and cause injury if not stacked correctly. Further-
more, the instruments at the bottom of the stack can be damaged due to the load
imposed by the instruments on top.
Observe the following instructions when stacking instruments:
● Never stack more than three instruments. If you need to stack more than three

instruments, install them in a rack.
● The overall load imposed on the lowest instrument must not exceed 500 N.
● It is best if all instruments have the same dimensions (width and length).

If you need to stack smaller instruments on the top, the overall load imposed on the
lowest instrument must not exceed 250 N.

● If the instruments have foldable feet, fold them in completely.

Positioning the Instrument
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3.2.2  Rackmounting

The instrument can be installed in a rack using a rack adapter kit. The order number is
given in the data sheet. The installation instructions are part of the adapter kit.

Risk of instrument damage due to insufficient airflow in a rack
If you mount several instruments in a rack, you need an efficient ventilation concept to
ensure that the instruments do not overheat. Insufficient airflow for a longer period can
disturb the operation and even cause damage.

3.3  Starting the Instrument

Risk of injury
Connect the oscilloscope to an outlet that has a ground contact.
If grounding is not ensured by the mains system, ground the oscilloscope using the
protective earth conductor on the front panel and an appropriate cable.
Do not use an isolating transformer to connect the oscilloscope to the AC power sup-
ply.

3.3.1  Powering On and Off

The R&S RTP can be used with different AC power voltages and adapts itself automat-
ically to it.

Refer to the data sheet for the requirements of voltage and frequency.

To power on

1. Connect the power cable to the AC power connector on the rear panel of the
R&S RTP.

2. Connect the power cable to the socket outlet.

3. Switch the main power switch at the rear of the instrument to position I.

The power key on the front panel lights up.

Before you start measurements, be sure to comply with the warm-up phase specified
in the data sheet.

Starting the Instrument
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If you leave the main power switch on, the instrument is in standby mode. To discon-
nect from power supply, power off the instrument. Powering off is only required if the
instrument must be disconnected from all power supplies.

To power off

1. If the instrument is running and the [Power] key is green, press the [Power] key on
the front panel to shut down the instrument.

2. Switch the main power switch at the rear of the instrument to position 0.

3. Disconnect the AC power cable from the AC power supply.

Risk of losing data
If you switch off the running instrument using the rear panel switch or by disconnecting
the power cord, the instrument loses its current settings. Furthermore, program data
can be lost.
Press the Power key first to shut down the application properly.

3.3.2  Starting Up and Shutting Down

The [Power] key is located in the bottom left corner of the front panel.

To start up the instrument

1. Make sure that the R&S RTP is connected to the AC power supply and the main
power switch on the rear panel is in position I.

2. Press the [Power] key on the front panel.

The instrument performs a system check, boots the Windows operating system,
and then starts the R&S RTP firmware.
The [Power] key turns green and the illuminated keys on the front panel light up. If
the previous session was terminated regularly, the oscilloscope uses the last set-
tings.

To shut down the instrument

► Press the [Power] key on the front panel.

All current settings are saved, and the software shuts down. The [Power] key turns
orange. The standby power supplies only the power switch circuits.
Now it is safe to power off the instrument.

The "Exit" function in the "File" menu shuts down only the firmware application. To shut
down the instrument completely, also shut down the operating system in the "Start"
menu, or use the [Power] key.

Starting the Instrument
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3.3.3  EMI Suppression

Electromagnetic Interference (EMI) may affect the measurement results.

To suppress generated Electromagnetic Interference:
● Use suitable shielded cables of high quality. For example use double-shielded RF

and LAN cables.
● Always terminate open cable ends.
● Note the EMC classification in the data sheet.

3.4  Connecting External Devices

The following interfaces for external devices are provided:

● USB connectors at the front and rear panel of the instrument
● Monitor connectors DVI-D and DisplayPort at the rear panel of the instrument

● Connecting USB Devices........................................................................................14
● Connecting an External Monitor..............................................................................15

3.4.1  Connecting USB Devices

The USB interfaces on the front and rear panels allow you to connect USB devices
directly to the instrument. The number of USB connectors can be increased by using
USB hubs. Due to the large number of available USB devices, there is almost no limit
to the expansions that are possible with the R&S RTP.

The following USB devices can be useful, for example:
● USB flash drives to save screenshots and measurement results, and for easy

installation of firmware applications
● Keyboard and/or mouse to simplify the operation and the entry of data, comments,

filenames, etc.
● Printer to print measurement results and screenshots

You can connect or disconnect all USB devices during operation of the instrument.

Installing USB devices on R&S RTP is easy under the Windows operating system,
because all USB devices are plug&play. After a device is connected to the USB inter-
face, Windows automatically searches for a suitable device driver.

If the operating system does not find a suitable driver, it prompts you to specify a direc-
tory that contains the driver software. If the driver software is on a storage media, con-
nect the appropriate drive to the instrument before proceeding. If the instrument is inte-
grated in a network, you can also install driver data stored in a network directory.

When a USB device is disconnected from the R&S RTP, Windows immediately detects
the change in hardware configuration and deactivates the corresponding driver.

The properties of external USB devices are configured in the operating system, not in
the R&S RTP software. It is recommended that you use mouse and keyboard to

Connecting External Devices
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access and modify the settings of the Windows operating system. To access Windows,
press the Windows key on the external keyboard, or select "File" > "Minimize Applica-
tion" on the R&S RTP menu.

Connecting a USB flash drive

If the installation of a USB flash drive is successful, Windows informs you that the
device is ready to use. The device is made available as a new drive ("D:") and is dis-
played in Windows Explorer. The name of the drive depends on the manufacturer.

Connecting a keyboard

The keyboard is detected automatically when it is connected. The default input lan-
guage is English – US.

To configure the keyboard properties:

1. Tap the "Find" icon (magnifier) on the Windows taskbar.

2. Type keybord.

3. Select "Edit language and keyboard options".

Connecting a mouse

The mouse is detected automatically when it is connected. To configure the mouse
properties:

1. Tap the "Find" icon (magnifier) on the Windows taskbar.

2. Type mouse.

3. Select "Mouse settings".

Connecting a printer

When printing a file, the instrument checks whether a printer is connected and turned
on, and whether the appropriate printer driver is installed. If necessary, printer driver
installation is initiated by the Windows system. To install a printer driver:

1. Tap the "Find" icon (magnifier) on the Windows taskbar.

2. Type printer.

3. Select "Printers & scanners".

4. Select "Add a printer or scanner".

3.4.2  Connecting an External Monitor

You can connect an external monitor or projector to the R&S RTP. The following con-
nectors are available:

● "DVI-D" on page 21
● "DisplayPort" on page 21

Connecting External Devices
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Before connecting an external monitor, ensure that the monitor and the R&S RTP are
connected to a ground contact. Otherwise the instrument can be damaged.

After connecting an additional monitor or projector to the instrument, configure it for
usage. The relevant settings are Windows settings but you can configure the displays
directly in the instrument setup.

1. Check the input type of the monitor or projector. Make sure to select the correct
cable. To use a VGA monitor, you need an active DVI-D to VGA adapter.

2. Press the [Setup] key.

3. Select the "System" tab.

4. Tap "Display / Monitors".

5. To show the instrument's display content only on the external monitor, select "Pro-
jector only".
To show the instrument's display content on both the oscilloscope and the external
monitor, select "Duplicate".

The touchscreen of the R&S RTP has a screen resolution of 1280 x 800 pixel. Most
external monitors have a higher screen resolution. If the screen resolution of the moni-
tor is set higher than the instrument's resolution, the application window uses a 1280 x
800 area of the monitor display. For full screen display, adjust the monitor's screen res-
olution using "Additional display settings".

Connecting External Devices
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4  Instrument Tour
This chapter describes the front and rear panels of the instrument including all function
keys and connectors, and also the touchscreen with its control elements.

4.1  Front Panel

Figure 4-1 shows the front panel of the R&S RTP. The function keys are grouped in
functional blocks to the left and the right of the touchscreen. Below the screen, various
connectors are located.

Figure 4-1: Front panel of R&S RTP

1 = Touchscreen
2 = Setup controls
3 = Horizontal controls
4 = Trigger controls
5 = Analysis keys
6 = Navigation controls
7 = External trigger input
8 = Vertical controls

Front Panel
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9 = Input channels
10 = Two option slots for R&S RTP-B1 (MSO) or R&S RTP-B1E (for R&S RT-ZVC) , R&S RTP-B6 (wave-

form generator), R&S RTP-B7 (pulse source)
11 = USB connectors
12 = Connectors for probe compensation and grounding
13 = [Power] key

Channel inputs and external trigger input

The R&S RTP has four channel inputs to connect the input signals, and an external
trigger input to control the measurement by an external signal.

The input connectors are provided with a special Rohde & Schwarz active probe inter-
face, and they are BNC compatible. Thus, the instrument can automatically detect
active probes that have the Rohde & Schwarz probe interface.

The input impedance of the inputs is 50 Ω.

Risk of instrument damage
The instrument is not rated for any measurement category.
Make sure that the input voltage on channel inputs and the external trigger input does
not exceed 5 V RMS at 50 Ω input impedance.

The keys and controls are described in Chapter 4.3, "Keys and Controls",
on page 22. The following connectors are available at the front panel:

Probe Compensation
Probe compensation terminal to support adjustment of passive probes to the oscillo-
scope channel.

Protective earth conductor for grounding the instrument.

Square wave signal for probe compensation, 1 kHz and 1 Vpp.

Ground connector for probes.

USB
Two USB type A connectors that comply with standard USB 3.0. They are used to con-
nect devices like keyboard, mouse, printer and USB flash drive.

Note: Electromagnetic interference (EMI) can affect the measurement results. To avoid
any impact, do not use USB connecting cables exceeding 1 m.

Front Panel
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Mixed signal option R&S RTP-B1 / digital extension port R&S RTP-B1E
One of the front panel slots can be used to install the mixed signal option R&S RTP-B1
or the digital extension port R&S RTP-B1E for R&S RT-ZVC multi-channel power
probe. The options provide connectors that can be used to connect two logical probes
with 8 digital channels each (D0 to D7 and D8 to D15), or two flat interface cables to
connect R&S RT-ZVC.

The maximum input voltage is 40 V peak at 100 kΩ input impedance. The maximum
input frequency for a signal with the minimum input voltage swing of 500 mV (Vpp) is
400 MHz. For detailed specifications, refer to the data sheet.

Waveform generator option R&S RTP-B6
One of the front panel slots can be used to install the waveform generator option
R&S RTP-B6. For detailed specifications, refer to the data sheet. The module provides
the following connectors:

[Gen1, Gen2] BNC connectors

[PattGen] Connector for the pattern generator

Pulse source option R&S RTP-B7
One of the front panel slots can be used to install the pulse source option R&S RTP-
B7. For detailed specifications, refer to the data sheet.

The module has four connectors.
● Out, : 2.92 mm connectors (K type) for pulse signal output
● Ref, : 2.92 mm connectors (K type) for reference signal output
 
Note: Three of the mentioned options can be installed in one R&S RTP - two at the
front panel, and one at the rear panel. Each option can be installed once only. To
ensure correct installation and calibration, installation is done only at Rohde & Schwarz
service centers. See also: "Option slot" on page 22.

4.2  Rear Panel

Figure 4-2 shows the rear panel of the R&S RTP.

Rear Panel
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Figure 4-2: Rear panel of R&S RTP

1 = AC power supply connector and main power switch
2 = USB device connector, type B
3 = USB connectors, type A
4 = LAN connector
5 = DVI-D connector for external monitor
6 = DisplayPort connector
7 = GPIB connector
8 = Exchangeable solid state disk (SSD, option R&S RTP-B18)
9 = Aux Out connector
10 = External trigger output
11 = Ref In, Ref Out: reference input, and output of the OCXO reference signal
12 = Digital data interface (DDI, optional)
13 = Option slot
14 = Kensington lock slot to secure the instrument against theft

AC power supply connector and main power switch
Connection to the AC power line. The R&S RTP can be used with different AC power
voltages and adapts itself automatically to it. The nominal voltage and frequency
ranges are displayed on the rear panel and quoted in the data sheet.

If grounding is not ensured by the mains system, ground the oscilloscope using the
protective earth conductor on the front panel and an appropriate cable.

The AC main power switch also interrupts the power supply of the OCXO.

When you power up the instrument, be sure to comply with the warm-up phase speci-
fied in the data sheet before you start measurements.

Rear Panel
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USB Device
USB 3.0 interface of type B (device USB), to be used for remote control of the instru-
ment.

USB
Four USB type A connectors. Two connectors comply with standard USB 3.0, and the
other two with standard USB 2.0. They are used to connect devices like keyboard,
mouse, printer, and flash drive to store and reload instrument settings and measure-
ment data.

Note: Electromagnetic interference (EMI) can affect the measurement results. To avoid
any impact, do not use USB connecting cables exceeding 1 m.

LAN
8-pin RJ-45 connector used to connect the instrument to a Local Area Network (LAN).
It supports up to 1000 Mbit/s (10/100/1000BASE-T Ethernet).

DisplayPort
DisplayPort connector for an external monitor or projector. It supports DisplayPort ver-
sion 1.1a.

DVI-D
Digital connector for an external monitor or projector. The monitor shows the complete
content of the instrument's screen.

GBIP
Connector with GBIP interface. For detailed specifications, refer to the data sheet.

Aux Out
Output of the internal calibration signal, if the signal is configured to external destina-
tion.

Trigger Out
The BNC connector for external trigger output is used to provide the internal trigger
signal of the oscilloscope to trigger other instruments for synchronized measurements.

When a trigger occurs, the R&S RTP creates a pulse of 5 V with a source impedance
of 50 Ω and delivers it to the external trigger output. The instrument can also send the
pulse on mask test violation or violation of measurement limits and margins.

If the connector is terminated with 50 Ω, the signal level is 2.5 V (50 mA). With 1 MΩ
termination, the level is 5 V. A short-circuit of the connector to ground creates current
of 100 mA.

To enable the trigger out signal, select "Trigger" menu > "Ctrl/Action". Here you also
adjust polarity, delay, and length of the pulse. The default is a positive pulse of 100 ns.
The minimum delay is 800 ns.

Ref In, Ref Out
BNC connectors for input of a reference signal, and for output of the OCXO reference
signal.

Rear Panel
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The input frequency ranges from 1 MHz to 20 MHz in 1 MHz steps. The input impe-
dance is 50 Ω.

The output frequency of the OCXO is 10 MHz, the impedance is 50 Ω. For detailed
specifications, refer to the data sheet.

DDI 40G
Optional digital data interface for input and output of digital data.

Option slot
Slot to install one of the options R&S RTP-B1 (MSO) or R&S RTP-B1E (for R&S RT-
ZVC) if both slots at the front panel are used for other options. To install the option, the
R&S RTP-B21 slot adapter ist required. The options and their connectors are briefly
described in Chapter 4.1, "Front Panel", on page 17.

4.3  Keys and Controls

4.3.1  Power Key

The [Power] key is located on the lower left corner of the front panel. It starts up and
shuts down the instrument's software.

The light of the key shows the instrument state:
● Orange: standby, the main power switch is on, the software is shut down.
● Green: The instrument is ready for operation.

4.3.2  Setup Controls

Setup keys set the instrument to a defined state, change basic settings, and provide
print and help functions. The intensity rotary knob adjusts the display contrast for sev-
eral display elements.

[Autoset]
The instrument analyzes the enabled channel signals, and adjusts appropriate horizon-
tal, vertical, and trigger settings to display stable waveforms.

[Preset]
Resets the instrument to a default state. All measurements, mask tests, zoom, and
most individual settings are deleted, and all channels except for channel 1 are dis-
abled. You can define preset configurations and save them to a file. The [Preset] key
can be configured to set either factory defaults or a user-defined preset configuration.

[Save Recall]
Opens and closes the "File" dialog box, where you can:
● Save instrument settings (user settings)
● Load instrument settings which were saved before

Keys and Controls



Instrument TourR&S®RTP

23Getting Started 1337.9946.02 ─ 03

● Save waveform data and measurement results
● Define a naming pattern for autonaming of files

[Setup]
Opens and closes the "Setup" dialog box, where you can:
● Access Windows configuration and install firmware updates
● Configure the touchscreen
● Check and install option keys for software options
● Check availability of hardware options
● Configure remote settings, LAN settings, and GPIB

Camera 
Performs the action that is assigned to the key in "File" menu > "Frontpanel Setup" >
"Hardkeys". By default, the key saves a screenshot of the waveform display.

[Help]
Opens the appropriate help topic for the active tab. If no dialog box is open, the con-
tents page of the help appears.

[Touch Lock]
Locks the touchscreen to prevent unintended use. When the touchscreen is off, the
key is illuminated. Press again to unlock the touchscreen.

[Display]
Opens and closes the "Display" dialog box to configure the appearance of the wave-
forms, the diagram layout, color tables, and the XY-diagram. You can also assign name
labels to the waveforms.

[Intensity]
Adjusts the intensity of the waveforms on the screen, or the background transparency
of dialog boxes, or the transparency of result boxes. If a dialog box is open, turning the
knob changes the transparency of dialog boxes. If a result box is open, the transpar-
ency of result boxes is changed. Otherwise the waveform intensity is adjusted. Press
the knob to toggle between the three settings. The controlled parameter and its value
are shown in the input box in the lower right corner of the screen.

4.3.3  Horizontal Controls

The keys and rotary knobs in the Horizontal functional block adjust the acquisition set-
tings and horizontal parameters. These settings are effective for all channel wave-
forms.
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[Res Rec Len], [Horizontal]
Open and close the "Setup" tab in the "Horizontal" dialog box, where you can:
● Adjust the time scale, and acquisition time
● Adjust the horizontal position, and reference point
● Adjust the resolution and the record length
● Enable the roll mode

[Acquisition]
Opens and closes the "Acquisition" tab in the "Horizontal" dialog box, where you can
define the acquisition processing (acquisition mode and waveform arithmetic).

[Resolution / Record Length]
The rotary knob changes the resolution or the record length. Press the knob to toggle
the setting. The controlled parameter and its value are shown in the input box in the
lower right corner of the screen.

For resolution, turn clockwise to increase the resolution: the time between two acquisi-
tion points gets shorter. Record length and sample rate increase while the acquisition
time remains constant.

For record length, turn clockwise to increase the record length, and the resolution
increases too - the time between to acquisition points gets shorter.

[Position]
The rotary knob changes the horizontal position of the waveform or the position of the
reference point on the screen.

You can select if the knob changes the position or the reference point in "File" menu >
"Frontpanel Setup" > "Knobs". To set the value to zero, press the knob. The current
value is shown in the input box in the lower right corner of the screen.

"Horizontal position" defines the time distance of the reference point from the zero
point of the diagram. Turn clockwise to move the waveform to the right.
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"Reference point" defines the position of the reference point on the screen. Turn clock-
wise to move it to the right. The reference point marks the rescaling center of the time
scale. It is indicated by a gray triangle outline at the top of the diagram. If you modify
the time scale, the reference point remains fixed on the screen, and the scale is
stretched or compressed to both sides of the reference point.

[Scale]
The rotary knob adjusts the time scale for all signals. The time scale is also known as
timebase.

Turn clockwise to stretch the waveforms. Doing so, the scale value time/div decreases.

Press the knob to toggle between coarse and fine scale adjustment.

4.3.4  Vertical Controls

The keys and knobs in the Vertical functional block select a signal and adjust the verti-
cal scale and position of the selected signal.

[Ch <n>]
Turns on, selects, and configures a channel. If the channel is active, the key lights up
in the corresponding channel color .

The effect of the keypress depends on state of the channel:
● If channel is off: Pressing the key turns on the channel and selects it.
● If the channel is on, but not selected: Pressing the key selects the channel wave-

form.
● If the waveform is selected: Pressing the key opens the "Vertical" dialog box for the

appropriate channel.
The vertical rotary knobs are focused on the selected waveform. They are illuminated
in the color of the selected waveform.
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[Logic]
Opens the dialog box for configuration of parallel buses and digital channels. The key
lights up if you enable at least one parallel bus. You can switch off the selected bus
using the [Signal Off] key.

[Ref]
Opens the "Reference" dialog box, where you can configure and display reference
waveforms. Press the key repeatedly to switch the reference waveform.

If a reference waveform is selected, the vertical rotary knobs are illuminated in white or
light gray (default colors), depending on the selected waveform.

[Math]
Opens the "Math" dialog box, where you can configure the calculation of mathematical
waveforms using various mathematic operations on other waveforms. Press the key
repeatedly to switch the math waveform.

If a math waveform is selected, the vertical rotary knobs are illuminated in brown
(default color), the brightness of the color depends on the selected waveform.

[Position] (upper knob)
The upper rotary knob changes the vertical position or the offset of the selected wave-
form. The horizontal axis and the selected waveform are moved vertically. The knob
lights up in the color of the selected waveform.

You can select if the knob changes the position or the offset in "File" menu > "Frontpa-
nel Setup" > "Knobs". To set the value to zero, press the knob. Turn clockwise to move
up the waveform. The current value is shown in the input box in the lower right corner
of the screen.
● Position indicates the vertical location in divisions.
● Offset moves the vertical center of the selected channel to the offset value.

[Scale]
This rotary knob adjusts the vertical scale for the selected waveform. The knob lights
up in the color of the selected waveform.

Turn clockwise to stretch the waveform. Doing so, the scale value V/div decreases.

Press the knob to toggle between coarse and fine scale adjustment.

[Signal Off]
Turns off the selected signal and selects the next channel, math, or reference wave-
form.

The key is illuminated in the color of the selected signal and changes the color accord-
ing to the new selection.

4.3.5  Trigger Controls

The keys and knob in the Trigger functional block adjust the trigger and start or stop
acquisition.
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[Trigger]
Opens and closes the "Trigger" dialog box, where you can:
● Select a trigger type and configure it.
● Set general trigger parameters and control the acquisition run.
● Qualify the trigger event with logic patterns.
● Configure a sequence of subsequent trigger events.
● Set up the zone trigger if option R&S RTP-K19 is installed.

[Levels]
The rotary knob sets the trigger level for all trigger types. Turn clockwise to move up
the trigger level. If the selected trigger type requires two trigger levels - upper and
lower level - press the knob to toggle between the two levels.

[Source]
Opens a dialog box where you can select the trigger source. Press the key again to
switch the source. The key lights up in the color of the selected trigger source.

[Slope]
Toggles the trigger slope or trigger polarity, dependent on the trigger type. The current
setting is shown on the trigger label, which is in the upper part of the sidebar.

[Mode]
Toggles the trigger mode between Auto and Normal. The current setting is shown on
the trigger label.

[Run Stop]
Starts and stops the continuous acquisition. A green light indicates a running acquisi-
tion. A red light shows that acquisition is stopped.
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[Single]
Starts a defined number of acquisitions. A green light indicates a running acquisition. A
red light shows that acquisition is stopped. Press the key again to stop running acquisi-
tions.

To set the number of acquisitions, press the [Trigger] key, select the "Ctrl/Action" tab,
and set "Average count (N-single count)".

4.3.6  Analysis Keys

The keys in the Analysis functional block provide direct access to measurement and
analyzing functions. If you press [Cursor], [Zoom] or [Meas], the action starts on first
keypress, and a second keypress opens the corresponding dialog box. If you press
another function key, the dialog box opens.

[Cursor]
Displays vertical and horizontal cursors in the active diagram and opens the "Cursor
Results" box.

Cursors are markers which are placed at points of interest on a waveform. The instru-
ment measures the cursor positions and delta values between parallel cursors.

If you press the key while a cursor measurement is enabled, the "Cursors" dialog box
opens.

In the "Cursors" dialog box, you can:
● Configure up to 4 cursor sets
● Define style and labels of the cursors
● Connect the cursor to the waveform and couple the cursors

[Meas]
Starts the default automatic measurement for the active waveform and opens the
"Measurement" result box.

If you press the [Meas] key while a measurement is enabled, the "Measurements" dia-
log box is displayed, where you can:
● Configure amplitude and time measurements, eye, spectrum, and histogram mea-

surements
● Configure gated measurement
● Configure long term and statistic measurements
● Configure actions to be executed if specified limits are exceeded
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App Cockpit 
Opens the "App Cockpit" dialog box, where you can start an application or analysis
function directly, without knowing its position in the menu or toolbar.

The "App Cockpit" button  on the left end of the menu has the same effect.

[Zoom]
Displays a zoom diagram for the active diagram. The key is illuminated if at least one
zoom is active. If you press the key while the zoom function is on, the "Zoom" dialog
box opens, where you can configure several zoom areas for detailed signal observa-
tion.

[Protocol]
Opens the "Protocol" dialog box which contains the configuration of serial buses and
the settings for decoding the signals.

The key lights up if the decoding of a serial bus is active. You can switch off the deco-
ded bus using the [Signal Off] key.

[Search]
Opens and closes the "Search" dialog box, where you can:
● Configure trigger events to be searched for
● Limit the search by gating
● Configure the presentation of search results

[Mask]
Opens and closes the "Masks" dialog box. Masks are used for error detection and
compliance tests of digital signals.

You can:
● Configure masks and masks segments
● Define mask test parameters
● Configure actions triggered by mask violation
● Configure the mask display

[History]
The sample memory contains several stored acquisitions before the current one, which
is shown in the display. Press the key to open the quick access "History" dialog box,
where you can view the stored acquisitions and use them for further analysis. Press
the key again to open the main "History" dialog box with more settings and information.

The key is illuminated as long as a history acquisition or replay is displayed.

FFT
Opens and closes the FFT setup.

The key lights up if an FFT is active. You can switch off the FFT math waveform using
the [Signal Off] key.
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4.3.7  Navigation Controls

The rotary knob and the navigation keys provide an alternative way to navigate in dia-
log boxes and to enter numeric data.

See also: Chapter 5.7, "Using Dialog Boxes", on page 51

Navigation rotary knob
The navigation knob has various functions:
● In numeric entry fields: turn to increase or decrease the value.
● In tables: press to activate the edit mode, turn clockwise to increase the value or

turn counterclockwise to decrease it, and press to enter the value and move to the
next cell.

● To set cursor positions, histogram areas, and mask points in input boxes: press to
toggle the parameter, turn clockwise to increase the value or turn counterclockwise
to decrease it.

● To move zoom area, cursor line, or gate in diagrams: Turn to move the element
that has the focus, and press to toggle the focus.

[Esc]
Closes a dialog box or input box.

[Undo]
Reverses the last setting actions step by step. Undo is not possible after load and
recall actions, and after creating a reference waveform.

[Redo]
Recovers the undo steps in reverse order.

[OK]
The [OK] key has various functions:
● In dialog boxes and opened selection lists: the key applies the selected value.
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● In tables: the key activates the edit mode. If the table cell is in edit mode, the key
confirms the value, quits the edit mode and moves to the next cell.

Field left, Field right
In dialog boxes and tables, the keys move the focus.

In diagrams, they switch the focus between zoom areas, cursor lines, and gates.

Checkmark [☑]
The checkmark key [☑] has different functions depending on the focus:
● In usual dialog box: if the focus is on a selection list, the key opens the list and

applies the selected value.
● In tables: activates the edit mode.

Tab
The tab key has various functions:
● In dialog boxes with only horizontal tabs, the key switches the horizontal tabs.
● In dialog boxes with horizontal and vertical tabs, the key switches the tabthat has

the focus.
● In a table or diagram, the key moves the focus in the same way as the [▶] key.

Up arrow [▲], Down arrow [▼]
The up and down arrow keys have the following effects:
● In numeric edit fields: increase or decrease the parameter value.
● In tables: scroll vertically through the rows.
● In dialog boxes, for option buttons in a column: select an option. In an open selec-

tion list, the keys scroll the list.

Left arrow [◀], Right arrow [▶]
The left and right arrow keys have the following effects:
● In edit fields: move the cursor.
● In tables: scroll horizontally through the columns.
● In dialog boxes, for option buttons in a row: select an option.
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5  Operating the Instrument
There are three ways to operate the R&S RTP.

Manual operation

Use the touchscreen, keys and rotary knobs, or an optional mouse and/or keyboard.
The principles of manual operation are explained in this section.

Remote control

Create programs to automatize repeating settings, tests, and measurements. The
instrument is connected to a computer that runs the program.

This way of operation is described in the user manual, chapter "Remote Control Com-
mands".

Remote operation

The remote desktop connection of Windows can be used for instrument control and file
transfer. Even on computers with non-Windows operating systems, a remote desktop
connection is possible using RDP applications.

For details, refer to the User Manual, chapter "Remote Desktop Connection".

Remote monitoring and control of the instrument from a connected computer is also
possible with a standard web browser and a LAN connection.

For details, refer to the User Manual, chapter "Web Control".

Alternatively, you can use Virtual Network Computing (VNC), which requires installation
of the VNC server on the R&S RTP. Installation and configuration are described in the
Application Note "Remote Monitoring and Control of the R&S RTP with a Web
Browser", available on the Rohde & Schwarz Internet.

5.1  Means of Manual Interaction

The R&S RTP provides the following means of manual interaction, which you can use
alternatively or complementary:
● Touchscreen:

Using the touchscreen is the direct interaction way. Use your finger to place wave-
forms on the screen, mark areas for zoom and histograms, set parameters in dia-
log boxes, enter data, and much more. The control elements and actions on the
screen are based on common concepts, and you will easily become familiar with
the user interface.
Tapping the screen works like clicking mouse buttons:
– Tap = click: Selects a parameter or provokes an action.
– Double-tap = double-click has the same effect as touch and hold = right-click:

Opens the on-screen keyboard or keypad, or a specific editor if available
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Use gestures to scale the waveform:
– Spread or pinch two fingers horizontally to change the horizontal scale (time-

base).
– Spread or pinch two fingers vertically to change the vertical scale of the active

waveform.
● Function keys and rotary knobs:

The front panel provides nearly all functions and controls to operate the instrument
in the classic ways, without touchscreen. As an exception, the sidebar cannot be
used with front panel controls.

● Optional mouse and/or keyboard:
These devices work conform to Windows standards. The navigation keys on the
front panel correspond to the keys on the keyboard.

The usage of the touchscreen and navigation keys is described in detail in the follow-
ing sections.

5.2  Touchscreen Display

5.2.1  Information on the Display

The touchscreen of the instrument shows the waveforms and measurement results,
and also information and everything that you need to control the instrument. All wave-
form-related display elements are shown in Figure 5-1. An overview of control ele-
ments - like dialog box, toolbar - is given in Figure 5-4 .

Touchscreen Display



Operating the InstrumentR&S®RTP

34Getting Started 1337.9946.02 ─ 03

Figure 5-1: Display information

1 = Diagram
2 = Grid
3 = Sidebar with horizontal and trigger label (3a), signal icon with waveform settings (3b) and signal icon

with minimized live waveform (3c)
4 = Trigger level
5 = Trigger position
6 = Reference point (distance from trigger position to reference point = horizontal position)
7 = Zoom area
8 = Zoom diagram
9 = Histogram area
10 = Histogram
11 = Messages

Diagram (1)
A diagram shows one or more waveforms: channel, reference, and math waveforms
together with histograms, masks etc. Zoom details, XY-waveforms, spectra and other
special waveforms are shown in separate diagrams.

By default, the diagram name contains the diagram number and the short names of the
waveforms shown inside. To change the diagram name, touch and hold the tab name.
The on-screen keyboard opens to enter the new name. Names must be unique.

To arrange the diagrams on the screen, the Rohde & Schwarz SmartGrid function
helps you to find the target place simply and quickly. For details, see "To arrange a
waveform using the SmartGrid" on page 41. You can also adjust the diagram size by
dragging the diagram border.
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Grid (2)
The grid shows the vertical and horizontal divisions. The division lines are labeled with
the correspondent values. The grid labels have the color of the waveform to which they
belong. If several waveforms are shown in one diagram, the grid has the color of the
selected waveform.

Sidebar (3)
The sidebar is the control center for all enabled waveforms. On the top, the horizontal
and trigger labels show the main timebase and trigger settings. If you tap a label, the
relevant dialog box opens with the tab used at last.

Figure 5-2: Horizontal and trigger label on top of the sidebar

1 = Resolution
2 = Record length
3 = Timebase (horizontal scale)
4 = Horizontal position
5 = Sample rate
6 = RT - real time, IT - interpolated time
7 = Trigger mode
8 = Trigger type, slope or polarity, source for A-event and B-event
9 = Trigger level

Below, each waveform is represented by a signal icon. If the waveform is shown in a
diagram, the signal icon displays its main vertical and acquisition settings. If you tap
the "Minimize" icon on the signal icon, the waveform switches from the diagram area to
the signal icon: the icon shows the real-time preview of the waveform. If you tap a sig-
nal icon, the dialog box with vertical settings for this waveform opens. See Chapter 5.4,
"Working with Waveforms", on page 39 for a detailed description.

In Figure 5-1, the signal icons Ch1Wfm1 and Ch2Wfm1 show the main settings, and
the waveforms are displayed in diagrams. All other waveforms are minimized and
shown in the signal icon.

Figure 5-3: Signal label on the sidebar
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1 = Vertical scale
2 = Vertical position
3 = Coupling and Termination
4 = Acquisition mode
5 = Offset
6 = Actual bandwidth, can be less than the instrument bandwidth depending on the number of active chan-

nels and other settings

If the sidebar contains many icons and not all icons are visible, touch one of the icons
and move it up or down until the required icon appears.

You can also switch off the sidebar: "Display" menu > "Diagram Layout" > "Show signal
bar" .

Trigger position and trigger level (4, 5)
The blue markers show the horizontal position of the trigger and the vertical trigger
level. You can touch and move the trigger markers in the diagram to set the positions.
The trigger point is the zero point of the diagram.

The trigger position can be moved outside the diagram. A red trigger position marker
indicates that the trigger position is not visible.

Reference point (6)
The reference point marks the rescaling center. If you modify the time scale, the refer-
ence point remains fixed on the screen, and the scale is stretched or compressed to
both sides of the reference point.

You can define the position of the reference point (Horizontal), and its time distance
from the trigger point of the diagram (Position).

Zoom diagram and zoom area (7, 8)
Zoomed waveforms are shown in separate zoom diagrams, in addition to the waveform
diagrams. On the original waveform diagram, a rectangle indicates the zoomed section
of the waveform - this is the zoom area. You can modify the zoom area by dragging the
rectangle as a whole, and by dragging its edges. To toggle between these modes, tap
the zoom area. You can also set exact positions.

The frames of the zoom area and of the associated zoom diagram have the same
color, different zooms are marked with different colors. So it is easy to assign zoom
area and zoom diagram.

As for waveform diagrams, you can change the name of the zoom diagram. A zoom in
a zoom and coupled zooms are also possible.

All zooming possibilities are described in detail in the User Manual, chapter "Zoom".

Histogram and histogram area (9, 10)
A histogram shows the frequency of occurrence of voltage or time values in a bar chart
directly in the diagram. The rectangular histogram area indicates the part of the wave-
form that is considered in the histogram. The vertical histogram counts the voltage val-
ues, and the horizontal histogram counts time values. You can switch between vertical
and horizontal mode, and modify the histogram area by dragging the rectangle as a
whole, by dragging its edges, or by setting exact positions.
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Messages (11)
A yellow or red button on the toolbar points to the status messages of the instrument.
To open the message box, tap the button. See also: Chapter 5.9, "Messages",
on page 54.

5.2.2  Control Elements on the Touchscreen

The touchscreen provides everything you need to control the instrument, to analyze
waveforms, and to get measurement results. Figure 5-4 shows the control elements on
a glance.

Figure 5-4: Control elements on the touchscreen

1 = Toolbar
2 = Sidebar, see "Sidebar (3)" on page 35
3 = Menu bar
4 = Dialog box
5 = Tab in a dialog box
6 = Result box
7 = Input box

Toolbar (1)
The icons on the toolbar provide quick and easy access to the most important function-
ality. For a detailed description, refer to Chapter 5.5, "Toolbar", on page 42.

Menu bar (3)
The menus provide access to the complete functionality of R&S RTP.
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Dialog box (4, 5)
The tabs of the dialog boxes contain all task-oriented settings and operations, and
black buttons for calling related tabs. The usage of dialog boxes is described in Chap-
ter 5.7, "Using Dialog Boxes", on page 51.

Result box (6)
If you perform manual or automatic measurements, mask testing, or a search, the
result box shows the results of the action. Similar to waveform diagrams, you can mini-
mize the result box to a result icon on the sidebar, and display results in a separate
diagram on the screen. The  icon opens the corresponding dialog box to adjust the
settings.

For details, see Chapter 5.6, "Displaying Results", on page 49.

Input box (7)
The input box appears if you adjust a value using one of the rotary knobs, or if you
drag an element on the screen, for example, a cursor line. The input box shows the
current value of the modified parameter. You can enter the exact numerical value,
change the step size, and - if available - autoset the value directly in the input box. The
box title shows the name of the currently adjusted parameter. The input box is helpful
when using the multi-function rotary knobs, for example, [Intensity], and [Resolution /
Record Length].

See also: Chapter 5.8, "Entering Data", on page 52.

5.3  App Cockpit

The app cockpit provides fast access to all available applications.

► To open the app cockpit:

● Tap  in the menu.
● Press the  key in the [Analysis] section of the frontpanel.
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5.4  Working with Waveforms

The R&S RTP can create and display several types of waveforms:
● Channel waveforms:

Up to three waveforms per input channel can be shown. For a four-channel instru-
ment, 12 channel waveforms are available.

● Reference waveforms:
Four waveforms can be used as reference for comparison and analysis.

● Math waveforms:
Four mathematic waveforms can be created with mathematic operations performed
on channel, reference, and other math waveforms.

● Zoom waveforms:
Show the details of waveforms.

● XY-waveforms:
Four XY-waveforms can be created. Each XY-waveform is built from the voltage
values of two source waveforms.

● Digital waveforms:
The Mixed Signal Option R&S RTP-B1 provides 16 digital channels grouped in two
logic probes (pods) with 8 channels each.

Waveform handling

The R&S RTP can show and analyze many waveforms. To handle this multitude while
keeping track of it, the R&S RTP provides intelligent support:
● The color system helps to distinguish the waveforms. The color of the vertical

rotary knobs indicates the signal that is focused (selected). The color of each
waveform can be changed, the color of its signal icon and of the illuminated keys is
adjusted to the new color. Alternatively, a color table can be assigned to a wave-
form. Settings: [Display] > "Signal Colors / Persistence" tab.
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● Waveforms can be minimized to signal icons showing a small real-time signal view.
Thus, more space in the diagram area is available without switching off waveforms.

● Diagrams are displayed on tabs – you can arrange them side by side or one above
the other. To change the diagram name, double-tap the tab name.

● The Rohde & Schwarz SmartGrid function helps to arrange the diagrams.

Waveform states

Depending on its place on the screen and the effect of settings, a waveform has one of
the following states:
● Off
● Active:

The waveform is shown in a diagram
● Selected:

One of the active waveforms that has the focus. In each diagram, one of the
assigned waveforms is selected – it appears "on top" in the diagram, and the grid
labels have the color of the selected waveform. Some of the toolbar functions, like
cursor and histogram measurements are performed on the selected waveform. All
waveform-specific settings are applied to the selected waveform of the selected
diagram. The vertical [Position] and [Scale] knobs, and the [Signal Off] key are illu-
minated with the color of the selected waveform.
In Figure 5-1, "Ch1Wfm1" is the selected waveform: The frame of the diagram and
the signal icon are highlighted.

● Minimized:
The waveform is shown as real-time signal view in its signal icon.

To switch a waveform on

A channel waveform is activated as soon as you connect the probe. You can switch it
on and off according to your needs.

► Choose one of the following ways:

● Press the channel key.
● In the "Vertical" dialog box, select the channel and tap the "Show channel" but-

ton.

The waveform is now active, selected, and is shown in the diagram.

To select a waveform

► Choose one of the following ways:

● Tap the waveform in the waveform diagram.
● To select a channel, reference, or math waveform, press the corresponding

key.
● Tap the signal icon.

Note: Zoom waveforms in zoom diagrams cannot be selected.
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To minimize a waveform

► Choose on of the following ways:

● Tap the "Minimize" icon in the upper right corner of the waveform's signal label
in the sidebar.

● Drag the waveform from the diagram to the sidebar.

The waveform disappears from the diagram and the minimized signal view is
shown in the signal icon.

Tip: To set the waveform back to its previous diagram immediately, use "Undo".

To arrange a waveform using the SmartGrid

You can arrange waveforms in one of the existing diagrams, or in a new diagram.

The usage of the SmartGrid is also shown in a short video that is available on the
instrument: "Tutorials > Getting Started > SmartGrid".

1. Drag the signal icon to the diagram area, and move it around.
The Rohde & Schwarz SmartGrid appears and a blue area shows where the wave-
form will be placed.

2. Drop the waveform in the target area.
The waveform appears in an existing or in a new diagram, and it is selected for fur-
ther actions.

3. To change the size of the new diagram, drag its edge to the required position.
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The diagram layout depends on the position where you drop the signal view, in relation
to an existing diagram.

Figure 5-5: SmartGrid positions

1 = In the existing diagram, overlay of signal
2 = New diagram on the left or right
3 = New diagram above or below
4 = New diagram on top of the existing diagram
5 = XY-diagram
6 = YX-diagram

To switch off a waveform

► Do one of the following:

● Select the waveform, and then press the [Signal Off] key.
● To switch off a minimized waveform, tap the "Close" icon in the upper right cor-

ner of the minimized signal view.
● Disable "Show channel" in the "Vertical" > "Channels" tab.
● Tap the "Delete" icon (Recycle bin) in the toolbar, and then the waveform.

If several waveforms overlap or lie close together, the upper (selected) wave-
form is switched off.

5.5  Toolbar

The toolbar provides direct access to important control and measurement functions. It
shows current date and time, and a message button. The selected function is highligh-
ted.

By default, the toolbar shows the most frequently used functions. You can configure the
content of the toolbar and hide the date/time display, see Chapter 5.5.2, "Configuring
the Toolbar", on page 43.

Toolbar
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5.5.1  Using the Toolbar

Using the toolbar is easy and straightforward.

Some of the toolbar functions are one-click actions. These actions are performed
immediately when you tap the icon.

Other toolbar functions are analyzing functions. These actions are interactive actions.

To use analyzing functions (interactive actions)

1. If several waveforms are shown in the diagram, select the waveform that you want
to analyze.
See: "To select a waveform" on page 40

2. Tap the icon of the function in the toolbar.

3. Check and adjust the settings in the sidebar on the right.

4. To define the analyzed area, do one of the following:

● Tap the required diagram.
● Drag a rectangle on the diagram.

The toolbar handling is also shown in a short video that is available on the instrument:
"Tutorials > Getting Started > Toolbar".

5.5.2  Configuring the Toolbar

You can configure the contents of the toolbar so that only the required functions are
displayed. Furthermore, date and time can be hidden. The toolbar configuration is part
of the user preferences. It is retained when you switch off and on the instrument, and
you can save it in the user preferences and user-defined preset.

Toolbar
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1. To open the toolbar configuration, choose one of the following ways:
● Tap the icon in the toolbar:

● On the "Display" menu, select "Toolbar".

2. Select the required toolbar functions:
● Disable the functions that you do not need.

Enable the functions that you want to add to the toolbar.
● To display all available toolbar icons, tap "Show All".
● To hide all toolbar icons, tap "Hide All".

3. To hide the current date and time on the toolbar, disable "Show date and time".

A detailed description of the toolbar functions is given in Chapter 5.5.3, "Toolbar Func-
tions", on page 44.

5.5.3  Toolbar Functions

This chapter describes all toolbar functions in detail.

Toolbar
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One-click actions Interactive actions

Undo Zoom

Redo Search

Show Help Cursor

Graphical Recall (load saveset ) Masktest

Save Settings Histogram

Save Screenshot Measurement

Create Report Quick meas

Clear all FFT

Autoset and Preset Delete

Run / Stop and Run Single Label

Find Trigger Level Update Ref Waveform

Force Trigger Save Waveform

 Spectrogram (option R&S RTP-K37)

 Zone trigger (option R&S RTP-K19)

You can configure the content of the toolbar and hide the date/time display, see Chap-
ter 5.5.2, "Configuring the Toolbar", on page 43.

The following list describes at first the default toolbar functions and then the additional
functions.

Undo
Undoes the last setting actions step by step. Some actions cannot be revoked: locking
the touchscreen with [Touch Lock], and saving data. The undo stack is deleted during
the following actions: Reloading settings from file, and reference waveform actions
(save, load and preset with active reference waveform).

Redo
Recovers the undo steps in reverse order.

Show Help
Enables the tooltip display. A short description appears when you tap a parameter in a
dialog or result box. To open the corresponding help topic, tap the "Show Help" button
in the lower right corner of the tooltip. See also: Chapter 5.10, "Getting Information and
Help", on page 55.

Graphical Recall (load saveset )
Opens a window to select and load instrument settings that were previously stored in a
saveset. A graphical preview helps you to find the required settings.

Toolbar
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Zoom
The zoom icon on the toolbar shows the last selected zoom type. A short tap on the
icon activates the selected zoom.

To use another zoom type, select it in the sidebar.

Standard zoom ← Zoom
Displays a magnified section of the diagram in an additional zoom diagram. It is a dis-
play zoom, instrument settings are not changed.

Tap the icon and drag a rectangle on the diagram to mark the zoom area. An additional
zoom diagram appears. You can use the tool also repeatedly on the zoom diagram to
get a more detailed view.

Touch and hold the zoom area to open the "Zoom" dialog box.

Hardware zoom ← Zoom
Changes the instrument settings - horizontal and vertical scales as well as trigger level
and offset - to display a part of the diagram in greater detail.

Tap the icon and drag a rectangle on the diagram to mark the area to be zoomed. The
diagram changes and shows the magnified area. To return to the previous display, use
the "Undo" function.

Coupled zoom ← Zoom
Creates a coupled zoom area and its related zoom diagram. If you change the size of
one zoom area, the size of all coupled zoom areas is changed as well.

First, create a zoom using the "Standard" zoom. Then tap "Coupled zoom" and tap the
existing zoom area. The zoom area is duplicated. Drag the duplicate to the required
position.

Fingertip zoom ← Zoom
Magnifies the waveforms around your fingertip.

Tap the icon and put your finger on the waveform. The touched part of the waveform is
displayed in a magnifier. Drag your finger on the screen to move the magnifier. You can
change the zoom factor using the Navigation knob.

Search
Performs a search. Tap the icon and adjust the settings in the sidebar. Tap the diagram
with the waveform to be searched, or drag a rectangle to define a search gate. The
search is performed on the selected waveform.

Cursor
The cursor icon shows the last selected cursor type. A short tap on the icon activates
the selected cursor.

To use another cursor type, select it in the sidebar, and adjust the settings.

Toolbar
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Tap the diagram where you want to set the cursors, or draw a rectangle in the diagram
to position the cursor lines. The resulting cursor lines measure the selected waveform.
The results appear in the "Cursor Results" box. You can adjust the cursor source, type
and position in the result box. Move the cursor lines by dragging them in the diagram,
or by turning the navigation knob. Pressing the knob switches the parameter to be
changed.

Masktest
Starts the on-screen mask definition and the testing against the defined mask.

Tap the icon and then tap the points that build the mask. Double-tap the last point to
finish mask definition. To create a rectangular mask, draw a rectangle on the screen.
You can move the mask on the screen.

To configure the mask test settings, tap the  icon in the "Mask" result box.

Histogram
The histogram icon on the toolbar shows the last selected histogram type. A short tap
on the icon activates the selected histogram.

To use another histogram type, select it in the sidebar, and adjust the settings.

Tap the icon and then drag a rectangle on the diagram to mark the histogram area. The
histogram for the selected waveform appears.

Touch and hold the histogram area to open the "Histogram" dialog box.

Measurement
Starts an automatic measurement.

You can run up to 8 automatic measurement groups in parallel. The "Automatic meas-
urment" icon starts the measurement groups one after the other.

A measurement group consists of minimum one measurement, and can consist of
many measurements of the same category. Tap the icon and select the measurements
in the sidebar. Tap the diagram with the waveform to be measured. To define a mea-
surement gate, draw a rectangle on the screen.

To modify the measurement, tap the  icon in the "Measurement" result box.

Quick meas
Performs a set of measurements on the selected waveform. You can configure up to 8
measurement to be included in quick measurement.

Tap the icon and then tap the diagram with the waveform to be measured.

FFT
Transforms a waveform to the frequency spectrum by fast Fourier transform (FFT). The
FFT trace is shown in a new diagram.

Tap the icon and adjust the settings in the sidebar. Tap diagram with the waveform to
be transformed. The FFT diagram is created from the selected waveform.

To adjust FFT settings, double-tap the FFT diagram.

Toolbar
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Delete
Removes zoom and histogram areas and their diagrams; measurement areas and their
associated results; and mask segments. The icon also switches off a waveform.

Tap the icon and then tap the area or diagram to be deleted, or the waveform to be
switched off.

Save Settings
Saves the current instrument settings in a saveset. The filename is created according
to the autonaming pattern. You can reload the saveset using the "Load saveset
(Graphical recall)" toolbar icon, or using [Save Recall] > "Save/Recall" > "Settings".

Save Screenshot
Saves a screenshot of the current display using the settings defined in "File" menu >
"Print Setup".

Create Report
Creates a report of the current measurement settings and results using the settings
defined in "File" menu > "Report Setup".

Clear all
Deletes all measurement results including long term measurement and statistics, all
waveforms, and the history.

Autoset and Preset
Performs an autoset, or a preset to a default state. The icons have the same function-
ality as the corresponding keys on the front panel. They are useful when you control
the instrument remotely.

Run / Stop and Run Single
Starts and stops the continuous acquisition, or starts a defined number of acquisition
cycles. The icons have the same functionality as the corresponding keys on the front
panel. They are useful when you control the instrument remotely.

Find Trigger Level
Analyses the signal and sets the trigger level to the middle of the signal peaks.

Force Trigger
Starts an immediate single acquisition. If the acquisition is running in normal mode and
no valid trigger occurs, use "Force Trigger" to confirm that a signal is available. Then
you can use the displayed waveform to determine how to trigger on it.

Label
Defines a waveform label that names or explains the waveform. Tap the icon and then
tap the waveform to be labeled. If you tap the display background, the label is assigned
to the selected waveform. Enter the label text using the onscreen keyboard. The text is
shown in the same color as the waveform. You can drag the label to another position.
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Update Ref Waveform
Copies the selected source waveform with all its settings to the reference waveform. If
the acquisition is running, the reference waveform is a snapshot. You can configure up
to four reference waveforms.

Select the required reference waveform (R1 to R4) in the sidebar.

Save Waveform
Exports the waveform data to file using the settings defined in [Save Recall] > "Wave-
forms / Results" > "Waveforms". The filename is created according to the autonaming
pattern.

Tap the icon and then tap the waveform to be exported. If you tap the display back-
ground, the selected waveform is exported, or a multichannel export is performed if
configured.

Spectrogram (option R&S RTP-K37)
Starts an FFT and the spectrogram. The FFT trace and the spectrogram are shown in
separate diagrams.

Tap the icon. Select the source in the sidebar, or tap diagram with the waveform to be
transformed. The diagrams are created from the selected waveform.

Zone trigger (option R&S RTP-K19)
Defines a zone trigger, which combines the trigger condition with the intersection or
non-intersection of one or more zones or masks.

Tap the icon and then tap the corner points of the zone on the screen.

5.6  Displaying Results

The results of automatic and cursor measurements, mask tests, and searches are dis-
played immediately in a result box.

There are several places to display the results:
● In a floating result box in front of the diagrams, which you can move on the display
● In a minimized view (result icon) on the sidebar
● In a separate tab
● For results of automatic measurements: in a docked tab below the diagram

The default position and the font size can be adjusted.

To arrange a result box on the display

► Touch the title of the result box and drag the box on the screen. The SmartGrid
indicates where the result box will be placed.

● If you drop the box on one of the buttons, the results are shown in a separate
tab besides, above, or below the diagram.

● If you drop the box on the sidebar, a result icon is created.
● If you drop the box somewhere else, a floating result box is created.

Ref 1
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1 = Floating result box
2 = Table in a tab on the left or right
3 = Table in a tab above or below
4 = New tab

To open the corresponding setup dialog box

1. In the result box, tap the  icon. Alternatively, double-tap the results.

2. If the sidebar opens, tap "Advanced Settings" in the sidebar.

The dialog box with corresponding settings opens.

To define the default position of results

1. Press the [Display] key on the front panel.

2. In the "Display" dialog box, select the "Diagram Layout" tab.

3. Under "Result box", select the "Default position":
● "Preview": result icon on the sidebar
● "Floating": floating result box in front of the diagrams

4. For result boxes of automatic measurements, the docked position is the default. In
docked position, the result table is placed below the diagram. To change the
default position of measurement results, select "Meas" menu > "Gate/Display" >
"Default" position.

To adjust the font size in result boxes

1. Press the [Setup] key.

2. Select the "Screen" tab.

3. Set the "Result dialog font size".

Displaying Results
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5.7  Using Dialog Boxes

All functionality is provided in dialog boxes as known from computer programs. You
can control the instrument intuitively with the touchscreen. This section provides an
overview of the accessing methods and describes how to use the dialog boxes.

Each dialog box has four icons in the upper right corner:

Go back: opens the previously opened dialog box.

Go forward: opens the next dialog box.

Minimizes the dialog box to a small box that only contains the last selected function.

Closes the dialog box.

For direct access to important control and measurement functions use the toolbar, see
Chapter 5.5, "Toolbar", on page 42.

To open a dialog box

► Perform one of the following actions:

● Tap the required menu, and then the menu entry.
● Press the function key on the front panel.
● If a results box is open, tap the  icon to open the corresponding dialog box.
● To open the "Vertical" dialog box of a waveform, tap its signal icon. For XY-

waveforms, the "XY Diagram" tab opens.
● Tap the horizontal or trigger label to open the "Horizontal" or "Trigger" dialog

box, respectively.

To minimize a dialog box

If you want to change only one setting during analysis, and you need to change it
often, you can display a small box that only contains the required setting.

1. Tap the function that you need to modify.

2. Tap the  "Minimize" icon in the upper right corner of the dialog box.

The dialog box turns into a small box that contains only the "Wfm Arithmetic" set-
ting.
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3. To restore the complete dialog box, tap the  "Maximize" icon in the small box.

To close a dialog box

► Tap the "Close" icon in the upper right corner.
Or:
Press the [Esc] key on the front panel.

To select an option in a dialog box

► Tap the required option.
Or:
Press the [⇤] and [⇥] keys to navigate to the required option. Then press the [☑]
key.

To select an option in a list

If many options are available - for example, for the trigger type - the options are provi-
ded in a list. The current selection is shown on the list button.

► Tap the list button. Then tap the required option.
Or:
Use the front panel keys:

a) Press the [⇤] and [⇥] keys to navigate to the list button.
b) Press the [☑] key to open the list.
c) Press the [▲] and [▼] keys to navigate to the required option in the list.
d) Press the [☑] key to select the marked option.

5.8  Entering Data

Most important parameters have their own rotary knobs on the front panel. When you
turn a knob, the input box appears the lower right corner of the screen, showing the
parameter name and current value.

Using rotary knobs

1. Turn the knob to change the value.

2. To toggle the increment, tap the "Steps" icon in the input box.

3. To set the parameter to the autoset value (if available), tap the "RESET" icon.

Entering Data
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For data input in dialog boxes, the touchscreen provides an on-screen keypad to enter
numeric values and units. For text input, the on-screen keyboard with English key lay-
out is used.

To enter values with the on-screen keypad

1. Double-tap the entry field.
The on-screen keypad opens.

2. Enter the numeric value using the following methods:

● To use the default value, tap "Reset" (if available).
● To use the minimum or maximum value, tap "Min" or "Max", respectively.
● To increase the displayed value in fixed steps, tap "Inc".

To decrease the value in fixed steps, tap "Dec".
To toggle between small steps and large steps, tap the "Steps" icon.

● To get the value that was used before the keypad was displayed, tap "Cur".
● To enter a user-defined value, tap the numbers and complete the entry by tap-

ping the unit button.
– The arrow buttons move the cursor left or right.
– "Bksp" deletes the last character before the cursor.
– "±" changes the sign of the value.
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To enter data with the on-screen keyboard

1. Double-tap the entry field to open the on-screen keyboard.
If available, you can also tap the keyboard icon on the right of the entry field.

2. Enter the text as you would on a normal keyboard.

● To enter a series of capital characters, tap "Caps".
To enter one capital character, tap "Shift".

● To use the currently defined value, tap "Cur". This is the value that was used
before the keyboard was displayed.

● The arrow buttons move the cursor left or right.
● "Bksp" deletes the last character before the cursor.

3. Tap "Enter" to complete the entry.

To enter numeric data in a dialog box with navigation controls

1. To navigate to the entry field, press the [⇤] and [⇥] keys.

2. To change the value with a small step size, turn the rotary knob.
Alternatively, press the [▲] and [▼] keys for a larger step size.

If you edit numeric data in tables, the entry field must be in edit mode. To activate the
edit mode, press ENTER, or the [☑] key, or the navigation rotary knob.

5.9  Messages

Status messages of the instrument are displayed for a few seconds. Then they are
saved in a message box in the upper right corner of the screen. By default, the mes-
sage box is closed. You can open it to read the messages and to delete them.

► To open and close the message box, tap the "Info" button.
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If no messages are available, the "Info" button is hidden.

Important messages are indicated by a red "Info" button. These messages cannot be
deleted, they remain until the problem is solved.

5.10  Getting Information and Help

In many dialog boxes, graphics are included to explain the way a setting works. For
further information, you can use the following sources:

● Tutorials demonstrate the general usage of the R&S RTP, for example, how to use
the SmartGrid.

● Tooltips give a short description of the parameter.
● The context help provides functional description on a setting, and the correspond-

ing remote command.
● The general help explains a dialog box, provides instructions, and general informa-

tion.

5.10.1  Displaying Tutorials

Tutorials are silent movies, which are available directly on the instrument, and on the
Internet. They show basic usage aspects.

To see a tutorial on the instrument

1. On the menu, tap "File".

2. Tap "Tutorials".

3. Tap the tutorial that you want to see.

5.10.2  Displaying Help

To display tooltips and context help

1. Enable the "Tooltip" icon on the toolbar.

2. Tap the parameter for which you need information.

The tooltip opens.

Getting Information and Help
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3. To open the corresponding help topic, tap the "Show Help" button in the lower right
corner of the tooltip.

The "Help" window opens and displays the comprehensive description and the cor-
responding remote command. You can browse the help for further information.

Note: The tooltip icon disables automatically when you tap a parameter. To show
another tooltip, tap the tooltip icon again.

To open general help

► Press the yellow [Help] button on the left side of the screen.

If a dialog box is open, the help topic for the current tab is shown. Otherwise the
"Contents" page appears.

5.10.3  Using the Help Window

The Help window contains several tabs:
● "View" - shows the selected help topic
● "Contents" - contains a table of help contents
● "Index" - contains index entries to search for help topics
● "Search" - provides text search

The Help toolbar provides some buttons:
● To browse the topics in the order of the table of contents: Up arrow = previous

topic, Down arrow = next topic
● To browse the topics visited before: Left arrow = back, Right arrow = forward
● To increase or decrease the font

To navigate the Help, use the touchscreen. Alternatively, you can also use the naviga-
tion keys on the front panel.

To search for a topic in the index

The index is sorted alphabetically. You can browse the list, or search for entries in the
list.

1. Switch to the "Index" tab.

2. Select the "Keyboard" icon besides the entry field.

3. Enter the first characters of the keyword you are interested in.

The entries containing these characters are displayed.

4. Double-tap the suitable index entry.
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The "View" tab with the corresponding help topic is displayed.

To search topics for a text string

1. Switch to the "Search" tab.

2. Select the "Keyboard" icon besides the entry field.

3. Enter the string you want to find.
If you enter several strings with blanks between, topics containing all words are
found (same as AND operator).

For advanced search, consider the following:
● To find a defined string of several words, enclose it in quotation marks. For

example, a search for "trigger qualification" finds all topics with exactly "trigger
qualification". A search for trigger qualification finds all topics that contain the
words trigger and qualification.

● Use "Match whole word" and "Match case" to refine the search.
● Use operators AND, OR, and NOT.

To close the Help window

► Select the "Close" icon in the upper right corner of the help window.
Or: Press the [Esc] key.

Getting Information and Help
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6  Setting Up the Instrument
Basic setup procedures for the instrument are the following:

● Performing a Self-alignment....................................................................................58
● Setting the Display Language................................................................................. 58

6.1  Performing a Self-alignment

The self-alignment aligns the data from several input channels vertically and horizon-
tally to synchronize the timebases, amplitudes and positions. The self-alignment proc-
ess includes a basic hardware check.

Recommendation on performing the self-alignment:
● When putting the instrument into operation for the first time
● After a firmware update
● Once a week
● When major temperature changes occur (> 5°)

Warm-up and prepare the instrument
Make sure that the instrument has been running and warming up before you start the
self-alignment. The minimum warm-up time is indicated in the data sheet.
Remove the probes from the input connectors.

1. On the "File" menu, select "Selfalignment".

2. On the "Control" tab, tap "Start Alignment".

The alignment is performed, the process might take several minutes. A message
box informs you about the running process, wait until this message box closes.
The overall pass/fail result is shown in the "Overall alignment state" field. The
results of the individual alignment steps for each input channel are indicated in the
"Results" tab. This information is required if problems arise.

6.2  Setting the Display Language

You can change the language in which the dialog boxes, result boxes and other screen
information is displayed. A reboot of the instrument is not necessary.

1. Press the [Setup] key.

2. Select the "System" tab.

Setting the Display Language
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3. Tap the "Language" button. The button shows the current language.

4. Select the required language.

The instrument changes the language after a few seconds.

Setting the Display Language
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